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SeniorNet Mac, Christchurch Executive and Committee

— Barbara Blowes

From  the President
SeniorNet Mac Inc. PO Box 475

Christchurch 8140
Email: Mac.SeniorNet@gmail.com

41 Essex Street, Christchurch
Web: http://seniormac.org.nz/

Pop in and have a cuppa in the 
clubrooms. You can get 

answers to computer problems, 
ask questions and get advice. 
If you need to bring in your 
computer please ring: 

Brian Henderson, 03-942-5293 or 
Allan Rutherford: 03-352-4950 in 

advance.
Items that can be solved quickly 
will be free but problems 
requiring significant time will 
attract up to $20 workshop 
charge.

The SeniorNet Mac Infoletter 
is distributed bimonthly on 10th 
April, June, August, October, 
December and February. Our 
CEO Allan Rutherford will 
keep you updated on important 
matters every week, in between 
times.

Friday Mornings

I would just like to thank everyone who helped us to shift 
into our new rooms. It was a big task to undertake but 

what super rooms we now have. I don’t have lots of keys 
to undo doors and an alarm to dis-arm  hoping that I have 
keyed it out right.
Our new rooms are lovely, light and best of all  warm. I have 
enjoyed taking classes there especially as the projector has been put on the ceil-
ing and I don’t have to fiddle with it to to get my iPad to work.
I have just updated to iOS 11 and High Sierra on the computer and imagine my 
surprise when I opened my computer and my watch made a funny clicking sound 
and I thought oh what’s wrong here but my great Apple watch had opened my 
computer, no password and a notice came up on my watch to tell me it had 
opened my computer. I think this is so clever but what next?
Next month is our Christmas social, this year has gone by so fast and my friends 
all say the same thing.
I am waiting to see what the new iPhones look like before I decide whether to 
give up my fags and booze next year!I 
I do hope you all have a wonderful Christmas with your families and friends and 
looking forward to maybe new goodies to learn with next year.   �

Season' Greetings
The SeniorNet Mac Executive 
and Members of the Committee 
wish you all a very Happy and 
Safe Holiday Season and Best 
Wishes for 2018.
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Deadline for December/January Infoletter
December 8th, 2017

Please have your copy for the next Infoletter to me by 
the above date.
Copy can be either typed straight into an email, as a 
Word file or as Rich Text Format.
Digital images need to be at least 220dpi  or higher 
(72dpi will not reproduce well)
Please no hard returns except at the end of a 
paragraph.

Hi there.
The end of this month is fast ap-
proaching, Christmas is not far 
away, thank goodness all the hoo-
hah from the Election Results are 
over! This will probably be the last 
Infoletter I will be producing on my 
old iMac. I have recently purchased 
a new iMac as the browsers on my 

old computer were out of date and could not be up-
graded. I’m finding Mail a wee bit weird on the new 
computer, but will probably get used to it in time. I 
would like to thank all the contributors who have sup-
plied me with copy for each Infoletter, they have made 
my job a lot easier.

I would draw your attention to the Disclaimer on page 3 
which appears in each Infoletter.   �
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Welcome to New Members

The Rata Foundation
Community Organised Grants Scheme
Photo & Video International
Also in association with:
The Federation of NZ SeniorNet Societies

Our Sponsors

EditorialContents

Gae Alderson, Lester Alderson, Roy Beer, 
Jill Bond, Anne Brown, Sharon Bull, Arnold Calje, 
Carmen Gimpi, Elizabeth Power, John Rowe
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You are invited to submit apple recipes for 
inclusion in future Infoletters.—Editor 

 Cookin’ with
Applebyte

No liability is accepted for any errors or omissions or inadvertent disclosure not meant for publication. Any opinions 
expressed may not necessarily reflect the views of the Editor or SeniorNet Mac Inc. who, likewise, neither endorse 
nor accept responsibility for products or services of any advertisers or for opinions expressed within the Infoletter.

Every effort has been made to ensure that no known copyright issues have been breached and 
that appropriate acknowledgements have been made, with regard to all articles and advice 
given in this publication.

Disclaimer

Advertisers
WANTED

•	Web Advertising on our Web Site
•	 Infoletter Advertising
•	Our Annual “Help” Booklet advertising

Reasonable Rates: For prices contact the 
CEO Allan Rutherford

Apple Betty
4 cooking Apples, peeled, sliced & cored.
3/4 cup sugar 
1 beaten egg
1 tablespoon melted butter 
1/2 cup sifted flour
1 teaspoon baking powder
Mix all together & turn into a greased dish. Cook in a 
moderate oven for 40 minutes.   �

is the monthly magazine of Canterbury Apple Users
a subgroup of Christchurch SeniorNet Mac Inc and is 
available as a PDF file, which is FREE to download from the 
website: www.appleusers.co.nz The free HELP email list is 
open to all Mac users who wish to give or receive assistance. 
See the website under ‘email list’ for instructions on how to 
subscribe or unsubscribe to this service.
AUG meets on the last Wednesday of each month at 
SeniorNet Mac Rooms, 41 Essex Street, Christchurch.
A heated room with all conveniences, tea/coffee and 
bikkies. 
FREE to SNM members. General public $4.00

              Apple User Group

RAFFLE WINNERS
September
Barbara Tonkin
Barbara Franklin
Lorelie Kennedy
Derek Brown

OCTOBER
Mary Nicholson
Dennis Long
Grace Adams

Courtesy Otago SeniorNet

100 years vs. 2 minutes
I found this in an email sent to me by Macphun. If you 
are having difficulty organising, storing or even trying 
to decide if you should keep or delete some of your 
photographs the following will explain why! “Every 
two minutes, we take more pictures than the whole 
of humanity in the 1800s.” If you are interested in a 
variety of information about photography have a look at: 
https://macphun.com/blog

courtesy—Pam Doughty Ausom news,10/2017
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On Monday the 2nd of October the annual Age Con-
cern Expo was held at the Papanui High School in 
Christchurch. It has a large percentage of support from 
non profit societies in the local community showing 
how they can support the elderly. Our SeniorNet Mac 

• At a recent committee meeting it was decided 
to hold two meetings at our new rooms in Essex 
Street for all our volunteer helpers so that we 
can inform them of all the features and security. 
Volunteers only need to attend one of the follow-
ing dates.
Friday 2pm on the 20th of October or
Tuesday 2pm on the 7th of November
Anyone wishing to volunteer for any purpose, 
should attend one of these meetings. Reply to the 
CEO if attending.   �

Age Concern Expo 2017
group as well as Canterbury SeniorNet had presenta-
tion booths at this Expo. There were several thousand 
visitors and we believe we will gain new members 
from it. 
See photo of our booth below.   �

Committee Reports
• It was also decided that the Christmas Social 
will be held on Tuesday 28th of November, not 
the first Tuesday in the month. This is our next 
social and the last social of 2017. Bookings and 
payments must be made to the Treasurer prior 
to the event. Cost this year is $33.00 per person. 
This is an all day event with the program start-
ing at 11am. More details will be posted to 
members.   �
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Tech Tips New Shapes available in iWork, 
using Pages Numbers or Keynote

The new shapes described here are available in the updated 
apps for the Mac, iPad, iPhone or iCloud.com To follow along 
I suggest you commence with a blank document in Pages 
although you could use Numbers or Keynote. The screenshots 
have been taken from Pages on a Mac. Not all the new 
features are available on the iPad and iCloud versions of 
Pages.

Select the Shape icon on the Tools menu.
There is now a choice of many different shapes under 
various headings in the sidebar.
Earlier versions of Pages had only the Basic shapes available.

courtesy—Pam Doughty, Ausom News, October 2017

Select Transportation from the sidebar.

Add a Shape to your Document
Do this by clicking one of the shapes offered.

It is great to have all these shapes available and to be able
to re-colour and re-size them however, you can also ‘break
them apart’.

Altering the Shape
To see what this means select the shape in your document
and then Format >Shapes and Lines > Break Apart.

Once your shape has been ‘broken apart’ you can see the
individual parts are ‘selected’. By clicking away from the 
shape to deselect it you can click to select and delete, move or 
resize any of the parts.

It is possible to change the colour fill of individual parts 
of your shape for use within a document. However, the 
individual parts all must have the same fill if you want 
to save your new shape. (See My Shapes later in this 
article).
You might want to add something to your shape.
Below I added four filled rectangles.

Continued on next page
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Tech Tips
continued

Saving your New Shape
With all of the parts of your new shape selected you can 
choose
Format > Shapes and Lines >Unite Shapes
And then you can choose
Format > Shapes and Lines >Save to My Shapes
My Shapes is another feature that has been added to the 
iWork apps for the Mac.

NOTE:
•	 My Shapes can be found under the Shape icon.
•	 Grouped shapes cannot be saved to My Shapes you 

need to use Unite Shapes; Intersect Shapes; Subtract 
Shapes or Exclude Shapes.

•	 If different colour fills are applied to parts of the shape 
using “Unite Shapes” or similar will give each part the 
same fill and the resulting shape can then be saved to 
My Shapes.      �

NO-SHOW WEBSITES
Why won’t some websites show up on my Mac, when they 
display without any problem on my iPad and/or iPhone?
Presumably you’re using Safari, Apple’s default web 
browser on your Mac. Not all websites are optimised for all 
browsers, and some in particular don’t work well on Safari. 
There are several things you can do:
• Quit and relaunch Safari - this can sometimes solve 
minor problems.
• Check your Safari extensions - there may be a conflict.
• Update Safari, and consider updating your System soft-
ware also, to take advantage of bug fixes.
• Use an alternative browser, such as Google Chrome.    �

courtesy—Sheryl Roberts,
Aoraki Mac Users Group

YOUTUBE VIDEO DOWNLOADING
In the past watching online video content could be quite 
expensive due to data restrictions, but the advent of both 
streaming and connection plans which allow for much 
greater (or unlimited) quantity of data have made it much 
cheaper to view online from sites such as YouTube and
Vimeo.

However, you may still want to download movies on 
to your Mac. Some applications and browsers (such as 
Firefox) enabled you to do this, but unfortunately there 
have been some issues with both these apps and brows-
ers when used with recent versions of Mac OS. Here are 
updated applications you can use:
MacX YouTube Downloader
Although entitled ‘YouTube’, this application works with other 
sites such as Vimeo, Facebook, Vevo, etc., and supports a 
variety of resolutions and formats.
Very easy to use, and it’s free! 
MovieSherlock
A fully-featured download application which works well, 
although it costs $NZ63.00. The free trial version allows 
you to download up to four videos. Thank you Tony and 
Hugh for describing these applications.     �

courtesy—Tony Climo and Hugh Hunter 
Aoraki Mac Users Group

A   A   A
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41 Essex Street ....Our New Rooms
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Courses & Workshops

November 2017
                                 Courses and Workshops
                                     November 2017
                          
                                                     4 Week  Courses: $40   
                                                     3 Week Courses:  $30
                                                     2 Week Courses:  $20

 Workshops, Discussion Groups:  $10 payable on the day. These are held at the SeniorNet rooms.

All of the above Courses and Workshops must contact: Allan Rutherford Ph 3524950 or email: 
ajmr@xtra.co.nzMembers with iPhones or iPads must have taken an iPhone or iPad introduction 
workshop before undertaking a course relative to their device.

Starts Ends

Photo for Mac 4 Weeks 1st Novemberr 22nd November Wednesday                   10am - Noon

Internet for Mac 2 Weeks 1st November 8th November Wednesday 2pm - 4pm

Number for iPad 4 Weeks 6th November 27th November Monday 10am - Noon

iPad Basics 4 Weeks 9th November 30th November Thursday 10am - Noon

Mac Basics 4 Weeks 9th November 30th November Thursday 2 pm - 4 pm

Notes for iPad /
iPhone

2 weeks 15th November 22nd November Wednesday 2 pm - 4 pm

Advanced iPad Tuesday 14th November 11am - 2pm

iPad Introduction Tuesday 14th November 2pm - 4 pm

December

Skype and FaceTime 5th December 10am - Noon

E 189 `I’m sick’—(How to call with a croaky voice) 
E 193 It’s not my job— (An introduction on how to get 
others to do your work)

Courses we won’t be offering
E 177 It wasn’t me!!—(A guide to blame)
E 186 Cover my back—(How to Drag friends in on 
Your mistakes)

—courtesy SeniorNet Motueka
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August 2nd
Di Lucas has worked around New Zea-
land on Urban and Rural planning and 
projects for more than 40 years.She has 
recently resigned as chair of the Nature 
Heritage Fund (1990- 2017). During this 
time she has worked extensively with 
communities and iwi towards sustaining 
and enhancing 750 sites and all sorts of 

eco systems on both on land and in marine settings.
She is a member of the Christchurch Urban Design Panel. 
She believes landscape is an amalgam of culture, nature 
and relationship of place. Di is a sought after government 
advisor with a deep knowledge of the land and what lies 
beneath it. She seeks knowledge from the past and uses it 
to inform others.
In Christchurch she knows about the intricate river and 
stream profiles and has worked on the urban design panel 
eg housing for the East frame, a peer reviewer for the Avon 
corridor and is on the reference group for the new plan for 
Cathedral  Square.
Di urged us to make comments and state opinions as they 
do influence bodies who are making decisions.The Cathe-
dral Square proposal is open for discussion now.
She is aware of the need for digital knowledge to be 
established as much of what scientists like her know, could 
be lost. 
Di Lucas is an amazingly busy woman with a lifetime of 
extensive scientific knowledge and experience gained from 
actively working in a wide range of NZ environments.  �

SeniorNet Mac  Social &
Luncheons

Wednesday
August 2nd
and 
Tuesday
September 5th

September 5th
“All things come to those who wait.” Our September Social 
meeting saw us back to a Tuesday, albeit the 1st Tuesday 
of the month. Allan announced another great achievement 
—new meeting rooms at 41 Essex Street which he showed 
us on the screen.
Mary Nicholson introduced our speaker—Senior Sergeant 

Ash Tabb, District Deployment Manager for the Canterbury 
District Police Force. Second in command of the 900 men 
and women police in Canterbury.
Senior Sergeant Tabb said that few people are aware of 
what police really do these days. Police work is no longer 
simply “catch & punish”. It is now based primarily on preven-
tion. What is causing the crime? The aim is to stop reoffend-
ing. The police are trained to first find out the “Why” and to 
work with those involved in criminal activities in an effort 
to turn their lives around. Is the crime the result of a mental 
problem, or illness? Is it drug or alcohol related? Is there a 
family background, homelessness, a lack of money to feed a 
family etc.? The “Intergrated Service Response” says that 30% 
of its work involves family violence with several thousand calls 
reported on 111 per day.
Our population and our tourists need to feel safe and to be 
safe. Often those with large investments are targeted by 
“criminals”. Apprehending, then providing help and under-
standing, can help prevent reoffending. Cameras, are set 
up in shops and on streets for identification purposes.
Another important role of the police is Civil Defense 
Emergency. The Port Hills fires are an example of this. The 
Fire Service at the time consisted of the Suburban Service, 
and the Rural Service. Their notification procedure resulted 
in delays. It has now been updated. Fortunately the Civil 
Defense Emergency enabled police to evacuate, reassure, 
and to stop journalists from going beyond a safe boundary .
The NZ Military Defense Force was called in to help. As 
fire generates its own weather patterns residents had to 
be evacuated fast. The first fire was not deliberate but 
the second outburst was. Senior Sergeant Tabb praised 
both the social media eg FaceBook—whereby the fire was 
reported within 15 minutes, and the great work done by 
helicopters.
The Earthquake was another situation involving Police & 
the Military. The first help came from the public and the 
police then later Urban Search & Rescue, and the Student 
Army.
Police work includes search and rescue. They work a lot of 
night shifts and go overseas for experience. Canterbury is 
also strong on Counter Terrorism.
This was an interesting and informative session that ended 
with Senior Sergeant Ash Tabb answering questions and 
showing us the surprising amount of unobtrusive equipment 
that is part of his uniform.   �

Today even kids have iPhones. When I was a kid, I felt cool with my new pencils.
                                                                                                                   —Anonymous
“

  “
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SeniorNet Mac  Social &
Luncheon

Tuesday
October 3rd

On Tuesday, 3rd. of October we were presented with an 
interesting insight into the life of Avrill Cullen and her late 
husband Max, in their quest for information into the life 
and activity of Bats. Avrill asked the members how they 
felt about Bats and some were obviously unhappy about 
them. She pointed out that most Bats, including the New 
Zealand ones, are insect eaters, while some are fruit eaters 
and the so called Vampire Bat only attacks animals with 
the tiniest prick! We were told that there are two types of 
Bats, known scientifically as from the Chiroptera family, 
native and living in New Zealand. They are designated as 
Short-tailed and Long-tailed and are the only Native Mam-
mals in the Country. Bats live in dark places such as under 
bridges, in holes in the trunks of trees and in clefts, etc. in 
cliffs. The New Zealand Bats feed at night on insects which 
they catch on trees and plants or in the air as they glide on 
their spread wings. Bats are the only mammals capable of 
sustained flight. Adult Bats are only approximately 8cms. 
long and will weigh between 10 and 22 grams while the 
babies weigh only 6 grams and growing. The wings are up 
to 15 cms. long and have boney ribs.
Avrill and her late husband travelled to many areas in 
New Zealand, Fiordland, the Cliffs near Fairlie, Murchison 
and Reefton in the South Island, being the areas with the 
largest populations. They also cycled through Italy, where 
they found the largest numbers of Bats, France and England 

Morning speaker:  
Grant Sidway, Executive officer, New Zealand, 
Federation of SeniorNets, Wellington.

Grant’s Subjects will be:
* Impacts of Social Media
* Technology Trends
* Wearable Technology
* Vitual Reality
* Being secure in a not secure    	
   world 

Afternoon Speaker: 
Mike Crean—Journalist, Author and Writer

“You Don’t Have To Be mad To Write a 
Book—But It Helps”

I was born and raised in Hawarden, North Canterbury, 
trained as a teacher and taught both primary and second-

ary in Southland, Otago and Canterbury. 
In 1985 I switched to a job at the 
Christchurch Star, to develop and present its 
new project, Newspapers in Education. 
This was to promote the use of news-
papers in schools as a tool in teaching/
learning. This was discontinued after 
four years but I stayed on at the Star as 

a features writer. As the Star declined from a paid daily 
paper to a free weekly I jumped the fence to The Press, 
in 1993. After 21 most enjoyable years there I retired in 
2015. My wife tells me I will not be adding to the total 
of four books that I have written. It is time to do things 
together, such as travel, she says. Our five children and 
seven grandchildren seem to agree.   �

and visited Greece and the U.S.A. to study the colonies 
in these places. Avrill told us of a town in America with a 
resident population of 35,000 while under a bridge there 
was a colony of 750,000 Mexican Bats. It was thought that 
the Bats should be eliminated but, after an outcry, the Bats 
were protected and have since become a huge Tourist At-
traction! The Cullens also went to Australia to investigate 
the Bat populations where there are 49 different types. 
Avrill and Max joined other people spending time at the 
Knobs Flat Research Station in Fiordland where they used 
special monitors to listen for Bat calls and flight noises. 
They also used Harp Traps which consist of fine strings 
that cause the Bats to flip side on and then drop harmlessly 
to the bottom of the trap where they can be seen through 
the clear plastic front. Time is then spent measuring and 
weighing for comparison. Nest boxes have also been 
placed in trees and watchers lie on the ground to observe 
and count the Bats.
Short-tailed Bats are fairly calm when being handled and 
do not bite but the Long-tailed will bite necessitating the 
wearing of gloves.
Avrill has spent many years in pursuit of her passion for 
studying Bats and was thanked for her presentation and 
the photographs that were shown of areas of interest and 
the equipment used.   �

Guest Speakers for November 28th

Christmas Social
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My name is Grace Adams. I grew up in Hornby being the 
seventh of eight children. Being one of the younger ones I was 
always able to enjoy the protective indulgence of my older 
siblings.
On leaving school I worked firstly at Tucks grocery store 
in Colombo Street, later as a nurse aid at Nurse Maude 
convalescent home as it was known at that time.
In 1965 Joe and I moved to Otematata where we lived for 
five years. While there I started helping with cubs as two of 
Joe’s sons attended.
In 1970, nearing the end of the Aviemore construction we 
moved to Alexandra. This we found a lovely spot to raise 
a family. During this time I worked  in the kitchen at Ranui 
rest home. 1966 saw us shifting again to Oamaru where we 
spent the next 25 years. 
During those years I managed the fish department at 
Woolworths then worked in the deli in New World. In 2002 
we decided to return to Christchurch where I once again 
worked for Nurse Maude. During our time in Oamaru we 
joined the NZ Motor Caravan Association, making many 
friends and enjoying our lovely country. I spent nine years 
on the local Canterbury committee, five as their chair-
person.
My first contact with Macintosh technology was in 1984 
when Joe brought his first computer, and over the last 
five years have enjoyed the job as tutor convener here in 
Christchurch.   �

Profile

Funny Answering Machine Messages
“Hello, you are talking to an answering machine. I am 
capable of receiving messages. My owners do not need 
siding, windows, or a hot tub. Their carpets are always 
clean. They give to charity through their office and do not 
need any pictures taken. They believe the stock market is a 
random gamble.
“Hi. John’s answering machine is broken. This is his refrig-
erator. Please speak slowly, and I’ll stick your message to 
myself with one of these magnets.
“Hello, this is Sally’s microwave. Her answering machine 
just eloped with her tape deck, so I’m stuck taking her 
calls. If you’d like anything cooked while you leave your 
message, just hold it up to the phone.”
“Hi. This is Steve. If you are the phone company, I already 
sent the money. If you are my parents, please send money. 
If you are my bank loan officer, you didn’t lend me enough 
money. If you are my friends, you owe me money. If you are 
female, don’t worry, I have plenty of money.”
“Hi. I am probably home. I’m just avoiding someone I don’t 
like. Leave me a message, and if I don’t call back, it’s you.”
“Hi. If you are a burglar, then we’re probably at home 
cleaning our weapons right now and can’t come to the 
phone. Otherwise, we probably aren’t home and it’s safe to 
leave us a message.”
“Hello.This is not an answering machine this is a tele-
pathic thought-recording device. After the tone, think about 
your name, your reason for calling, and a number where I 
can reach you, and I’ll think about returning your call.”

Far Out Answering Machine Messages
“I can’t come to the phone right now because I’m down in 
the basement printing up a fresh new batch of twenty-dol-
lar bills. If you need any money, or if you just want to check 
out my handiwork, please leave your name, number, and 
how much cash you need after the tone. If you’re from the 
Department of the Treasury, please ignore this message.”

“Thanks for calling Dial-A-Shrink. I can’t come to the phone 
right now, so after the tone, please leave your name and 
number, then talk briefly about your childhood and tell me 
what comes to mind when you hear the following words: 
orange ... mother ... unicorn ... I’ll get back to you with my 
diagnosis as soon as possible.

“After the tone, leave your name, number, and tell where 
you left the money. I’ll get back to you as soon as it’s safe 
for you to come out of hiding.”

“The President is not in his office at this time. Please leave 
your name, phone number, the name of the country you 
wish to invade, and the secret password.”   �

a time 
to laugh
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Brian the Pirate’s Tips

Tip #1

continued on next page

If you use Gmail, set up OS X Mail to access Gmail quite 
easily and have both the accessibility of Gmail and the 
speed of OS X Mail.

To Access a Gmail Account in OS X Mail
To set up a Gmail account in OS X Mail with seamless ac-
cess to OS X Mail folders:
	 1	 Open Mail app and select Mail in the Menu bar in OS 

X Mail. From dropdown choose Add Account.
	 2	 Select Google under Choose a Mail account pro-

vider….
	 3	 Click Continue.
	 4	 Type your Gmail email address over Enter your 

email.
	 5	 Click NEXT.
	 6	 Now enter your Gmail password over Password.
	 7	 Click NEXT.
	 8	 With Gmail 2-step authentication enabled:
		  (a) Enter the code received by SMS or generated in an 

authentication app over Enter the 6 digit code.
		  (b) Click NEXT.
	 9	 Make sure Mail is checked under Select the apps to 

use with this account.
	10	 Click Done.

Access your Gmail Account in OS X Mail 7 Using 
IMAP

To set up a Gmail account in OS X Mail using IMAP—
which provides seamless access to labels:

	 1	 Make sure IMAP access is enabled in Gmail.
	 2	 Open Mail app and select Mail in the Menu. From 

dropdown choose Preferences
	 3	 Go to the Accounts tab.
	 4	 Click + (plus sign) under the accounts list.
	 5	 Select Google under Choose a mail account to 

add….
	 6	 Click Continue.
	 7	 Under Name …. Type your full name.
	 8	 Under Email address …. Enter your Gmail address.
	 9	 Under Password …. Enter your Gmail password.
	10	 Click Set Up.
	11	 Ensure Mail is checked under Select the apps to use 

with “(Gmail email address)".
	12	 Click Done and close the Accounts preferences 

window.

HOW2 Access a Gmail Account in OS X Mail
Access a Gmail Account in OS X Mail Using 

POP
To set up OS X Mail so it merely downloads new mes-

sages arriving at your Gmail address
to your inbox:
	 1	 Make sure POP access is turned on within the Set-

tings of the Gmail account you
want to set up in OSX Mail.
	 2	 Open Mail app and select Mail in the Menu. From 

dropdown choose Accounts
	 3	 To Add a New Account … Click + (plus sign) 

under the accounts list.
	 4 	 Click Continue.
	 5	 Under Name … Type your name
	 6	 Under Email Address … Enter your Gmail address
	 7	 Under Password … Type a purposely wrong 

password e.g.. 1,2, 3, 4, 5 etc
	 8	 Click Sign in.
	 9	 Under Account Type … select POP
	10	 Under Incoming Mail Server … Enter "pop.gmail.

com"
	11	 Now under Password …. enter your correct 

Gmail password
	12	 Click Sign in again.

Regurgitated for Seniors from notes by Heinz Tschab-
itscher 14 February 2017
< www.lifewire.com/gmail-os-x-access-1172876 >

HOW2 Transfer Contacts from 
Vodafone eMail Service
You can export (transfer) contacts from the Vodafone web-
mail service into your new email service as a vCard which 
is an industry standard.
Contacts which can be exported as a vCard are as follows:
•	 es.co.nz
•	 ihug.co.nz
•	 pcconnect.co.nz
•	 quik.co.nz

Tip #2
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•	 vodafone.co.nz
•	 vodafone.net.nz
•	 wave.co.nz
Contacts which cannot be exported are clear.net.nz and 
paradise.net.nz, these need to copied over manually.
Steps to export your contacts from Vodafone webmail
1	 Log into Vodafone webmail
2	 From the top right, click on Address Book, which opens 

your contacts
3	 In the Address Book screen, your contacts are shown by 

Groups and individually
4	 Select the Groups or separate contacts to export
5	 Either select specific separate individual contacts by 

holding the Command button while clicking on the items 
you want to export. Or Select All to export all contacts.

6	 From the icons above the Contact column, click on the 
Folder with a down arrow icon, which is Export your 
contacts in vCard format

7	 Your computer will then prompt you as to where you 
want to save them

8	 Click Save.
You can follow these steps to import your contacts into 
another email service

HOW2 Keep My eMail Address
Keeping your existing email address depends on who your 
provider is... some let you keep your email address and access 
through the web free of charge. Others look to hold you to 
ransom, stop you taking it with you or charge you if you want 
to keep it when you move.
Spark or Telecom Email Address
Spark provided email accounts which are usually under 
Xtra. Spark will charge you about $5 a month to keep your 
email address, if you don’t already have a spark connection 
with them. Most other providers charge a similar amount.
Vodafone Email Addresses
Vodafone announced it will close its email accounts on 30 
November 2017. This includes all email addresses ending 
in vodafone.co.nz, vodafone.net.nz, ihug.co.nz, paradise.
net.nz and clear.net.nz. Vodafone is encouraging customers 
to sign up for a Google Gmail or Microsoft Outlook email 
address and is offering an auto-forwarding service.
Other Email Addresses
Other providers will have different policies and it is 
VERY important to find out exactly what happens 
and what you should do BEFORE your switch goes 
live with your new broadband provider. It is recommend 
that you don’t retain your old email address— make the 
change now.
The recommendation is to sign up to a web-based service 
with an email account from a major provider such as Gmail 
(from Google), or Outlook (formerly Hotmail from Microsoft) 
making you ISP independent.
Such email web based accounts are packed with features, 
having quite large, free, storage allowances and with no 
chance of your email address being deleted when switch-
ing your broadband provider. You also rid yourself of lots of 
junk mail.

HOW2 Move your email address
If you are looking to move ISP / email address and don’t want 
to be tied down to paying for the service, here’s a simple 
process to ease the migration to a new email address.
1.	 Set up a new, free, web based email account like Gmail 

or Outlook. eg. create a Google Account through the 
Google Account creation page and establish a user-
name and password to sign in to Gmail

2.	 Set up a forwarding rule on your old paid for email 
account, such as Xtra from Spark, and have that email 
account forward all mail to Gmail / Outlook

Tip #3

continued on next page
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Life before the computer
Memory was something that you lost with age. 

An application was for employment

A programme was a TV show or a Concert

A CD was a bank account

A cursor used profanity 

A Hard Drive was a long trip on the road 

A Flash Drive was if you owned a Rolls Royce

“Those were 

the days...”

3.	 Notify all your contacts that you are changing your email 
address.

4.	 Set up a filter in Gmail / Outlook to label all emails 
received and redirected from your old email account as 
“Recidivists” (or similar). As emails are redirected in 
to this address update account details as they come in 
leaving and/or ignoring things you’re not interested in.

5.	 Remind people who continually email the old email ac-
count that you are switching address are the ones who 
end up with the “Recidivists” label.

6.	 Send a final reminder to the recidivists two months after 
the original notification of change of address.

7.	 Pull the plug on the old email account at the end of the 
third month.   �

continued from previous  page A Keyboard was a Piano

A File was something you used on your nails or in your 
workshop 

A Folder was usually  made of Manila Cardboard

If you had a 3 ½ inch floppy disk ....you just hoped nobody 
found out

A Web was a spider’s home

A Virus was the ‘flu 

A Mouse Pad was where a mouse lived

A Tiff was an argument between husband and wife

Software was a comfortable sweater

Phishing was something you did from a wharf or a boat

A Mail Alert was the Postman’s whistle after he delivered 
your letters to your letterbox   �

—courtesy SeniorNet Otago (with additions Editor)


